A software for an air quality modeling system

Z. Q. Yao
Nanjing Research Institute of Environmental Sciences for Electric Power, China

Abstract

A new air quality modeling system (AQMS) was developed by the author. It can simulate dispersion from point sources, area sources, linear sources and volume sources and will be used as regulation models in the electric power industry in China. A 32-bit software for this system has been developed. It can be run on a PC with Windows 95, 98 or NT installed. The software includes three modules: a preprocessing module, dispersion calculation module and plot module. A help file and a tutor file have been built into the software. The user can obtain instructions on any step of the operation if he or she presses the F1 function key or clicks on the help tool with the mouse. The tutor file can teach the user to use the software step by step. The software has a Chinese version and an English version.

1 Introduction

In order to allow the user to apply the new air quality modeling system without any difficulties, a 32-bit software with user-friendly interface has been developed. It can be run on any PC with a 486 and above CPU, 32 MB RAM and Window 95, 98 or NT installed. It can handle both gaseous and particle air pollutants no more than 1296 sources totally, which can be point, area, linear or volume sources, and at most 43,200 receptors. In most cases, the area source, linear source and volume source will be divided into some smaller pieces. The latter will be treated as point sources in dispersion calculation.
sources, and at most 43,200 receptors. In most cases, the area source, linear source and volume source will be divided into some smaller pieces. The latter will be treated as point sources in dispersion calculation.

2 AQMS system

The system is developed based on HPDM, AERMOD and other state of the art models and modified according to the meteorological data availability in China. A coastal fumigation model and building wake model have also been included.

2.1 Meteorology data

2.1.1 Boundary layer parameters

Atmospheric boundary layer (ABL) is classified as two categories according to the sign of the sensible heat flux: stable and unstable. The friction velocity $u_*$, temperature scale $\theta_*$, Monin-Obukhov length $L$ and sensible heat flux $H$ are calculated from routine meteorological data by profile approach or flux approach depending on available data (Holtslag [1], van Ulden & Holtslag [2], and Beljaars & Holtslag [3]). When a measured mixing height is unavailable, a temperature extrapolation method (Holzworth [4]) or calculation method will be used. In calculation option, Nieuwstadt [5] model $h_d = 0.3U_*L/1.9h_d - L/1.9$ is recommended under stable conditions. For improving instant change of $h_d$ with $u_*$ and $L$, a damping is applied: $dh/dt = (h_d-h)/\tau$, and $\tau = \beta h/u_*$. Under unstable conditions, the prognostic model of Batchvarova and Gryning [6] is adopted.

2.1.2 Profiles of wind velocity and temperature

When the observed wind velocity and temperature on the plume height is unavailable, they will be obtained by the calculation from the surface observation data through the profile relations (Beljaars and Holtslag [3], Cimorelli et. al. [7]).

2.1.3 Turbulence

Wind velocity deviations $\sigma_u$ and $\sigma_w$ are required in calculation of both dispersion parameters $\sigma_y$ and $\sigma_z$. The values of $\sigma_u$ and $\sigma_w$ at plume height must be given.
When the measurement data are available, they should be used. Otherwise, the calculation method based on Panofsky et al. [8] and Hicks [9] would be applied. Universal functions of $\sigma_y$ and $\sigma_z$ are applied in dispersion parameter calculation.

### 2.2 Plume rise calculation

When a plume is discharged from a stack, it will rise because of initial momentum and/or buoyancy. Briggs [10, 11] theory is used for plume rise calculation. The momentum rise, buoyant rise, stack tip down wash and penetration into the inversion (Hanna and Paine [12]) have been considered. The trajectory model is used before the plume reaches the final rise.

### 2.3 Dispersion models

Two kinds of sources are considered in this system: elevated source and surface source. The divided line to distinguish the surface and elevated sources is set at the smaller height of $0.1h$ and $0.1|L|$, where $h$ is boundary layer or mixed layer height, $L$ is Monin-Obukhov length.

#### 2.3.1 Dispersion from elevated source

##### 2.3.1.1 Dispersion in unstable conditions

A PDF model is applied in unstable conditions. As same as AERMOD model, the concentration is supposed to be contributed from three sources: (1) a real or direct source, (2) an indirect source, and (3) a penetrated source. Considering the reflection on the top of the mixing layer and on the ground (no flux condition), some virtual sources are cumulated. The concentration distribution on the crosswind direction is assumed to be Gaussian. But it will be bi-Gaussian (summation of two Gaussian distributions) on the vertical direction in both direct source and indirect source and Gaussian in penetrated source.

##### 2.3.1.2 Dispersion in stable conditions

In the stable conditions, both the crosswind and vertical distribution of the pollutant are assumed to be Gaussian. If the effective plume height is less than the boundary layer height, the deflection
from the boundary layer top is considered. Otherwise, deflection will not be included.

2.3.2 Dispersion from surface source
Surface sources will use the same dispersion model as elevated sources in unstable conditions and will use different dispersion models in stable conditions.

2.3.2.1 Dispersion in unstable conditions
The dispersion model for surface source in unstable conditions is the same as the dispersion model for elevated source but without the third part, penetrated source, because the plume is impossible to penetrate the inversion in this case. However, the expressions for vertical dispersion parameters of the direct source will differ in general.

2.3.2.2 Dispersion in stable conditions
Venkatram [13] model is used for the crosswind integrated ground level concentration caused by a surface source in stable conditions. The crosswind distribution of the concentration is assumed to be Gaussian. The vertical distribution of the concentration will be calculated according to Horst [14] model.

2.3.3 Other models
Besides mentioned models, some other models are also included in this system. They are coastal fumigation models from Misra [15] and Li and Yao [16], wake model from Weil [17], linear source model, area source model, volume source model and large particle model. A long-term algorithm is also included.

The system has been evaluated using Cox and Tikvart [18] statistical procedure with Nanticoke database and it was found that the basic modules gave better predictions than HPDM model did overall (Yao [19]).

3 Software

The software named AQMS4W32 contains three main parts: a preprocessor for data management, a dispersion calculation module and a postprocessor for treatment of output data. The preprocessor will manage initial data input, data
file edit, meteorology data analyses and data validation check. The dispersion module will calculate the plume rise, hour-averaged concentration and dry deposition. User can obtain long term (daily, monthly and annual) averaged concentrations, view and print out the data and plot the contours with postprocessor. Three modules are organized into one control window without any gap. It looks like most spreadsheet software (Figure 1). There is a menu bar on the top, a tool bar underneath and a data table located on the center. The software supplies a help system and a tutor file. User can obtain constructions at anytime when he or she press F1 function key or click on the tool with the mouse.

![Figure 1: Main window of AQMS4W32 software](image)

### 3.1 Data management

Some initial data files must be supplied in order to run the software. They are site data file, source data files, receptor data file and meteorology data files. The
building data and topographic data are also required for running building wake model and complex terrain model. All data files including output data files are named with two-character site code plus some other characters or numbers representing source ID and time. Different types of data files will be identified by different file extension. The first character in three-character extension will contribute to the pollutant type, the second to the average time and the third to the receptor type. The site data file contains the information such as latitude, longitude, surface moisture, roughness albedo and so on. The source data files give the information such as source size, height, emission rate and so on. AQMS system can handle point source, area source, line source and volume source with total number no more than 1296. Two characters or numbers are given for each source as its ID. The receptor data includes receptor's position coordinates and height. The software accepts two types of receptors: scattered receptors and grid receptors. The model system uses one hour averaged meteorology data in plume rise and dispersion calculation. User can choose “Input New Data” from “File” menu or click on the tool icon 📋 to build a new data file. He or she can choose “Open File” menu or click on the tool 📜 for modifying existing data file. User can print out the data by choosing “Print” menu or clicking on the icon 📹 tool. Before printing, the “Print Preview” menu lets the user to see what the output will look like. After setting-up the initial data files, user can carry out data validation check by choosing “Data Check” menu. The initial data files can also be prepared with other spread sheet software such as EXCEL or QUATRO PRO and then imported by choosing “Import Data” from “File” menu. The initial meteorology data must be analyzed to generate necessary boundary layer parameters by running “Analyzing Meteorology Data” from “Run” menu. The analyzed meteorology data files have the same record construction but with different file extension.

3.2 Dispersion calculation

The hour-averaged concentration or dry deposition can be calculated by choosing “Dispersion” from “Run” menu. User can run dispersion models for point source, area source, linear source, volume source and particulate source individually or all sources onetime through by choosing “Full Process”. Daily,
monthly and annual averaged concentrations or dry depositions can be obtained by running “Long Term Average” from “Dispersion” menu. User can also obtain any number of maximum concentrations by choosing “Maximum Concentration” from “Run” menu. User does not need to supply plume rise data file when he or she carries out dispersion calculation, the software will do it automatically. However if user wants to get plume rise data separately, he or she can run “Plume Rise”. There are two options: “Buoyant Gas Plume” and “Particulate”. In this case, the software will output plume rise data files. Each record will contain time, ambient temperature at stack top, buoyant flux, momentum flux, distance where final plume rise arrives, final plume rise, effective stack height, down wash height, penetration coefficient.

3.3 Output processing

The calculated plume rise, concentration and dry deposition data are saved on the disk as data files and can be viewed or printed out. User can view the concentration data by choosing “Concentration Data” from “View” menu or click on the tool with the mouse. A contour figure can be plotted by choosing “Contour Plot” from “Run” menu or click on the tool when the concentration data are displayed on the table. Only concentration data for grid receptors can be plotted. User is required to supply some information for the coordinate system, such as axis title, maximum distance, main marks, contour numbers, contour values and so on. The figure will be displayed on a sheet and can be saved as bitmap file or print out as a hard copy. Figure 2 shows an example of the contours. Displayed data, ether initial data or calculated data can be printed out on a paper by choosing “Print” menu.

3.4 Help file and tutor file

The software has a help file and a tutor file. User can get help during the software running by press F1 key or click on the tool with the mouse. He or she can also get information by choosing “Contents” on “Help” menu. A tutor file is included in this software. It teaches the user to run the software step by step.
3.5 System requirements

A PC with 486 or higher processor, 32 MB or higher RAM, 100 MB free space hard disk with Windows 95, 98 or NT installed, a mouse or other pointing device, a VGA monitor are the basic requirement. More powerful processor should be adopted for a great number of receptors and sources, especially for the area sources, linear sources or volume sources, because they will be divided into many point sources in AQMS system.
3.6 Further improvement

The software is still in continuous improvement not only because it may have some bugs, but also more functions need to be equipped. The plot feature, such as different depth of the color for different concentration level, combining with GIS system and so on, should be enhanced in next version. Directly Internet data transfer will also be added. More output data process will be supplied in order to meet national standard requirements.

References


